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Welcome to PaperPort
Welcome to the ScanSoft® PaperPort Getting Started Guide. 

PaperPort® provides the easiest way to turn paper into organized digital 
documents that everybody in an office can quickly find and use. PaperPort works 
with scanners, multifunction printers, and networked digital copiers to turn 
paper documents into digital documents. It then helps you to manage them 
along with all other electronic documents in one convenient and easy-to-use 
filing system. 

PaperPort’s large, clear item thumbnails allow you to visually organize, retrieve 
and use your scanned documents, including Word files, spreadsheets, PDF files 
and even digital photos. PaperPort’s Scanner Enhancement Technology tools 
ensure that scanned documents will look great while the annotation tools let you 
add notes and highlights to any scanned image.

Installing and Activating PaperPort 
You can install PaperPort from a CD or from the Web. 

The PaperPort installation program provides easy step-by-step instructions. 
Follow the instructions on each screen to install the software.

Installation and un-installation require Administrator rights; for Activation and 
Deactivation you need web access. You will be invited to activate the product at 
the end of installation. Provided your serial number is found at its storage 
location and has been correctly entered, no user interaction is required and no 
personal information is transmitted.

If you do not activate the product at installation time, you will be invited to do 
this each time you invoke the program. PaperPort 10.0 can be launched only five 
times without activation.
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Registration
Registration enables you to take full advantage of ScanSoft product support and 
to receive notifications of product updates.

When you finish installing PaperPort, you are prompted to register online. If you 
want to update your registration information, you can always go to the ScanSoft, 
Inc. web site at http://www.scansoft.com.

Learning PaperPort
This guide introduces you to PaperPort and shows you how PaperPort can help 
you manage your information. Additional sources of information to help you 
learn how to use PaperPort include online Help, Release Notes, and the ScanSoft 
web site.

Using this Guide

This guide is written with the assumption that you know how to work in the 
Microsoft Windows environment. Please refer to your Windows documentation 
if you have questions about how to use dialog boxes, menu commands, scroll 
bars, drag and drop functionality, shortcut menus, and so on.

Using online Help 

The PaperPort online Help includes comprehensive information on features, 
settings, and procedures. Help is available from the PaperPort Help menu.

Additional technical support, including technical notes, frequently asked 
questions, software updates, and more is available from the PaperPort Help 
menu. 

Using release notes

PaperPort Release Notes provide important information about this release of 
PaperPort. This document is included on the installation CD, from the 
PaperPort Help menu, and as a sample document on the PaperPort desktop.
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Technical Support
ScanSoft offers both complimentary and fee-based technical support options 
designed to meet your individual needs. Our services offer person-to-person 
telephone and e-mail technical support. We also offer self-service, 24-hour access 
to our Knowledge Base. 

Visit http://www.scansoft.com for information about your support policy, local 
support contacts, and product updates. Before contacting ScanSoft, be sure to 
read the user documentation and review the Release Notes.

Minimum System Requirements
A computer with an Intel® Pentium® or higher processor

Microsoft Windows® 98 (from second edition), Windows Me, Windows 2000 
SP4 or above, Windows XP SP2 or above

Microsoft Internet Explorer 5.5 or above

128MB of memory (RAM), 256MB recommended

150MB of free hard disk space for application files plus 5MB working space 
during installation

5MB for Microsoft Installer (MSI) if not present. (This is present as part of the 
operating system in Windows Me, Windows 2000 and Windows XP)

SVGA monitor with 256 colors, but preferably 16-bit color (called High Color 
in Windows 2000 and Medium Color in XP) and 800 x 600 pixel resolution

Windows-compatible pointing device

CD-ROM drive for installation

Web connection (with IE 5.5 or above) for activation and web update

 

Performance and speed will be enhanced if your computer’s processor, memory, and 
available disk space exceed minimum requirements. This is especially true when 
handling very large color image and PDF files. 
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What’s new in PaperPort 10?
PaperPort 10 includes a number of valuable new features to help you manage 
your documents. 

Page thumbnails 

See page thumbnails for your multi-page items, both in Desktop view and in the 
PageViewer. Get a better overview of your documents – find, handle and reorder 
pages quickly. 

Scanner Enhancement Technology tools

Improve your image items with the SETTM tools – now accessible directly from 
your PaperPort desktop by right-clicking on any image file. Annotation tools let 
you mark up your image items.

New Scanner Wizard

Set up scanners with PaperPort more easily, then enjoy improved scanner 
controls with greater scope for acquiring multi-page documents without 
interaction.

Better searching

The new All-in-One SearchTM facility delivers more power and precision, both 
on full-text searches and on keywords and other file information.

PDF creation

Generate image-only PDF files. Use the Duplicate as PDF command for image 
items, including MAX files. Print text items to PDF from inside PaperPort or any 
print-enabled application on your system. Full-text searches can be performed on 
these files in PaperPort with the All-in-One Search.

Extended form functionality

A Print Only Fields tool in FormTyperTM lets you use PaperPort to fill in pre-
printed forms.
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Extended shortcut menus

Find far more functionality when right-clicking an item – be it a file or a folder.

Greater flexibility with stacking and unstacking

PaperPort now provides greater choice for stacking together desktop items of 
different file formats and offers more options in unstacking. 

Folder improvements

Use the Folder Manager to organize your PaperPort folder structure, find more 
functionality in the folder shortcut menus and utilize the Back button to 
navigate through your folder tree quickly and easily.

Closer integration with other ScanSoft products

• If you have ScanSoft OmniPage® Pro on your system, PaperPort cooperates 
with it more closely than ever, providing cutting-edge OCR page recognition 
services and high-level PDF creation.

• If you have ScanSoft PDF Converter for Microsoft® Word on your system, 
it will appear on the Send To bar, allowing you to unlock PDF files and 
transform them into editable Word documents.

The following advanced features are available only in PaperPort Professional 10:

Two-part desktop

Split the PaperPort desktop into two Workspaces, to make it much easier to 
compare, move or copy pages between documents at different locations. 
Bookmark your Workspaces for one-click return to favorite locations.
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Fully-featured PDF creation

The latest ScanSoft PDF Create! product is included, letting you create more 
compact higher-quality 1.5 version PDF files. Files created from any text 
application are searchable and editable. Create PDF files from PaperPort or any 
print-enabled application on your system, with precise control over compression, 
font embedding, password protection, watermarking and more. The program 
can be accessed through the Windows Start Menu, the PaperPort Print dialog 
box and the Print to PaperPort (PDF) menu item in the File menu. The program 
has its own Help systems.

Index Manager

Schedule full-text indexing of your items for the All-in-One Search to run as 
background processes at times of your choosing.

DesktopDelivery

Set up system folders to be monitored by DesktopDeliveryTM for files of 
specified types to be automatically transferred to PaperPort folders. Acquire 
e-mail attachments in a similar way.

PaperPort is also supplied in Special Editions to selected scanner manufacturers and other resellers.
The feature set in these editions may vary, in line with each vendor’s requirements.
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Getting to Know PaperPort
This section introduces you to the different parts of PaperPort. Refer to the 
PaperPort Help for detailed information about all these topics.

The PaperPort desktop
The PaperPort desktop appears with the Folders pane when you first start the 
program. It displays your documents, as well as the tools you can use to manage 
them. PaperPort offers all the tools necessary to organize, find, and use 
documents and images.

 

Function pane can present:
• Folders (View menu)
• Page Thumbnails (View menu)
• Item Properties (View menu)
• Scan or Get Photo (File menu)
• All-in-One Search (Tools menu)

Image item thumbnail Text item thumbnail

Access to 
other pages

Folders

Command bar

Desktop

Send To bar
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PaperPort items
The documents and photographs you acquire in PaperPort are called items. 
There are two types of items: image items and text items.

Image items are scanned documents, photographs, and other digital items in an 
image format, such as PDF, JPEG, TIFF, or PaperPort Image (.max).

You create image items from documents, photographs, line art, or other items 
that you scan, copy, or bring in to the PaperPort desktop. 

Text items are documents that contain editable text, such as Word (.doc), 
HTML, and Excel files, and are created by word processing and other text-based 
applications. 

You can use any flavor of PDF file (PDF Image, PDF Searchable Image, and 
PDF Formatted Text and Graphics) with PaperPort. PaperPort distinguishes 
between image-only and non-image PDF items. You can use the SET tools to 
improve the quality of PDF-image only items.

You can quickly send an item to another program without leaving the PaperPort 
program. Just drag an item onto the link icon in the Send To bar at the bottom of 
the desktop. PaperPort supports a wide variety of programs including word 
processing, spreadsheet, fax, Internet e-mail, graphics, optical character 
recognition (OCR), and online services programs. 

PaperPort includes a My PaperPort Documents folder containing items to 
demonstrate some of the types of items you can keep on the PaperPort desktop. 

You can also use PaperPort to view non-PaperPort items that reside on your 
computer. Simply copy or move the document file or photo into a PaperPort 
folder.

The Folders pane
The Folders pane presents a hierarchical view of your PaperPort folders, similar 
to the view you see in Windows Explorer. 

PaperPort installs a PaperPort folder named My PaperPort Documents into 
your My Documents folder. If you are using a multi-user system, each user has 
their own My PaperPort Documents folder.
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The My PaperPort Documents folder contains several subfolders whose names –
such as Articles, Business Cards, Photographs, and Receipts – illustrate the 
different ways you can organize your items in PaperPort. 

The Samples folder contains sample documents and photographs to help you get 
started using PaperPort. 

When you have acquired your own PaperPort items, you do not have to use the 
My PaperPort Document folder to store them. You can add other local and 
network folders to PaperPort's Folder View. You can also delete the My PaperPort 
Documents folder, but your PaperPort structure must contain at least one folder.

PaperPort item thumbnails
There are two kinds of thumbnails in PaperPort: item and page thumbnails. Each 
item thumbnail is a small, graphic representation of your document or photo. 
Page thumbnails show pages of image items and PDF files in the Page 
Thumbnails pane both on your PaperPort desktop and in the PageViewer.

One quick way to locate your PaperPort items is to visually browse through the 
item thumbnails on your PaperPort desktop. Thumbnails show you what’s in a 
document without having to open it. In addition, thumbnails give you the ability 
to scroll through the pages of the document without opening it.

PaperPort shows large, clear thumbnails of all your documents and photos, 
including:

• Scanned pages and photos

• Photos from your digital camera

• Image files in many formats, such as BMP, TIFF, JPEG, GIF, and MAX

• Microsoft Word, PowerPoint, Excel, Word Perfect, and other documents 
created in popular software programs

• PDF documents

• PDF Image items

• HTML documents 

To show or hide the Folders pane, click the Folders button on the Command bar. 
With the desktop split, Folders panes can be displayed for each Workspace.
PaperPort Getting Started Guide 13



Each item thumbnail appears with an icon that identifies the program in which it 
was created or is currently associated. This makes it easy and convenient to 
quickly see and find all different types of items on your computer.

Click on a thumbnail to see image attributes. A small  icon indicates that the 
Read-only attribute is set for that item. A small  icon indicates that the image 
has annotations. Multi-page image items show  to let you scroll through the 
pages even with the Page Thumbnails pane closed.

Before you can work with an item, you must first select its thumbnail on the 
PaperPort desktop. A red line appears around an item to indicate that it is 
selected. While working with item thumbnails, you can: 

• Drag a thumbnail to reposition it on the PaperPort desktop.

• Drag a thumbnail to a folder to move the item to that folder.

• Drag a thumbnail to another open Workspace to move the item to that open 
folder.

• Double-click a thumbnail to view the item.

• Press the Ctrl key and double-click a thumbnail to open the item in its 
source program.

• Right-click a thumbnail to display the item’s shortcut menu.

• Drag a thumbnail to the Send To bar to send a copy of the item to another 
program.

Just as you can organize and arrange documents on your physical desktop, you 
can quickly rearrange the items on the PaperPort desktop. For example, after 
selecting a thumbnail, you can reposition it or rotate it. 

Using item thumbnails on the PaperPort desktop, you can also easily combine 
individual PaperPort Image items or PDF Image items into multi-page items. 
This feature is useful as an organizational tool if you are using a scanner that can 
only scan a page as a separate item. 
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PaperPort page thumbnails
The Page Thumbnails pane on the PaperPort desktop and in PageViewer 
displays thumbnails for multi-page image items. Select a multi-page item, then 
click the Page Thumbnails button or use the View menu. Page-level operations 
can be done quickly without having to open the files – these are available for 
PDF files (both on the PaperPort desktop and in PageViewer) and MAX files 
(desktop only). In the pane you can:

• Enlarge or reduce thumbnail size.

• Copy, paste, cut, delete and reorder pages.

• Insert new pages at a certain location in the document.

• Append new pages at the end.

• Copy and move selected pages to a Workspace as separate PDF files.

• Copy and move pages between separate documents open in different panes.

Two-part desktop
When you first start PaperPort Professional 10, the desktop appears split into two 
Workspaces – top and bottom. This layout gives you a better oversight necessary 
to organize and combine your documents more effectively even in a cross-folder 
fashion. Right-click the active Workspace or use the Views button to change the 
way of viewing. If you work with documents containing multiple pages, you can 
use the corresponding function pane to view page thumbnails without having to 
open the given document. You can also use these desktop areas to view your 
folders, or the properties of the selected item. To remove the desktop split, open 
the Desktop menu, and uncheck the Split Desktop menu item.

You can also bookmark the Workspaces of your choice by using the Bookmark 
Workspace command from the Desktop menu. To manage them, use the 
Organize Bookmarks command. Getting to a frequently used Workspace is just 
a mouseclick away, since they are all displayed in the same menu.

The Page Thumbnail view of a secure PDF is only available by supplying its 
password.
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The Page View window
The Page View window allows you to take a closer look at your items and to 
touch up and annotate them. You can also enlarge or reduce the view for easy 
reading. Use the SET tools to enhance the current page image. Use the Page 
Thumbnails pane to edit your document at page level.

To view an item in the Page View window, double-click an item thumbnail, 
choose View from its shortcut menu or select the item and click the Page button 
on the Command bar. 

Active 
Workspace

Send To bar

Inactive 
Workspace

Function pane 
showing page 
thumbnails 

Desktop split

Function pane 
showing folders

Annotation Tools

SET Tools

Desktop button:
click to return to the 
PaperPort desktop

Page Thumbnails 
Pane
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Acquiring Items
There are many ways to bring images and documents into PaperPort so that you 
can use PaperPort’s viewing, editing, annotation, indexing, OCR, and file 
management tools. For example, you can:

• Scan photos, pages, and other images on a scanning device.

• Add folders to PaperPort that already contain images and documents.

• Capture snapshots of web pages.

• Import files from other programs on your computer.

• Print documents from other programs to the PaperPort desktop.

• Drag or cut-and-paste images and documents from Windows Explorer, or 
other programs to the PaperPort desktop.

• Acquire photos from a digital camera.

• Bring files into PaperPort Professional 10 using DesktopDelivery.

Scan to the PaperPort desktop
PaperPort is designed to work with TWAIN- and WIA-compatible scanners. 
(ISIS support is only included in PaperPort Professional 10.)

Click the Scan or Get Photo button to start scanning. In the Scan pane, you can 
choose between using the native interface of the scanner or utilizing the new 
Scanner Settings pane of PaperPort for best scanning results. To use the interface 
of the scanner driver, mark the checkbox Display scanner dialog box. Leaving it 
empty will display the PaperPort panel with two tabs.

• Output: set file format and automatically suffixed file names.

• Scan: adjust scan settings: mode, resolution, size, orientation, filter color, 
brightness and contrast.

When the scan is complete, you will see your item on the PaperPort desktop.

If your scanner does not use a TWAIN, WIA or ISIS device driver, use the program that 
came with your scanner to scan items. Then, copy or move the scanned items to 
PaperPort. Refer to the PaperPort Help for more information about scanning.
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PaperPort makes it easy to scan pages as separate items or as a multi-page item. 
To scan and collate two-sided pages on your ADF scanner, flip the pages when 
prompted, click Scan Other Side, and PaperPort will automatically scan and 
collate the pages in the correct order.

Set up your scanner with PaperPort
All files needed for scanner setup and support are copied automatically during 
the program’s installation, but no scanner setup occurs at installation time. 
Before using PaperPort for scanning, your scanner should be installed with its 
own scanner driver software and tested for correct functionality. Scanner driver 
software is not included with PaperPort.

Scanner setup is done through the Scanner Setup Wizard. You can start this 
yourself: by clicking the Scan or Get Photo button, then the Setup button in 
the Scan pane. You can also start the Wizard from ScanDirect by right-clicking 
the Scan button. Otherwise, it appears when you first attempt to perform 
scanning in ScanDirect. Follow the on-screen instructions to set up your scanner.

Print to PaperPort
To bring items in from other programs, you can print them to the PaperPort 
desktop as PDF Image or PaperPort Image (.max) items. 

This feature lets you quickly import spreadsheets, pictures, database files, word 
processing files, and other files into PaperPort as items on the PaperPort desktop. 

In PaperPort Professional 10, you can use Print to PDF to print the document in 
PDF Formatted Text & Graphics format. 

You can use the Print to PaperPort capability to create print-formatted views of 
web pages. 

You can also use a high-speed, networked scanner to scan items to a networked 
folder and then add the folder to PaperPort. Use DesktopDelivery (available in 
PaperPort Professional 10) to monitor folders for incoming scanned images.
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Capture web pages
You can use Web Capture to capture web pages on the Internet as PaperPort 
Image items or PDF Image items on your PaperPort desktop. These items 
function as convenient pointers to your favorite web sites.

Once you capture a web page, you can perform a variety of activities. For 
example, you can:

• View the page.

• Save the page for archive purposes.

• Go to the actual web page on the Internet (PaperPort Image item only).

• Index the content of captured web pages.

Add PaperPort folders
PaperPort provides an easy-to-use filing system for organizing your items and 
sharing them with others. In the Folders pane, you can:

• Add existing folders on your computer to the Folders pane. 

• Create new folders, mapped network drives and folders on external devices 
attached to your computer. 

Initially, the Folders pane shows a set of folders designed to help you get started 
using PaperPort. You can move or delete these folders whenever you prefer. 

You can add folders already on your computer to the Folders pane, including 
network folders and folders on external devices attached to your computer. 
Documents within these folders are then available for use within PaperPort.

Refer to the PaperPort Help for more information about adding and using 
PaperPort folders.

Use the Print to PaperPort feature to create print-formatted views of web pages, which 
can also be added to the All-in-One Search index for searching by text content.
PaperPort Getting Started Guide 19



Use DesktopDelivery
DesktopDelivery (PaperPort Professional 10 only) monitors network or local 
folders for incoming files of specified types (PDF, TIFF, JPEG and MAX). It can 
also monitor e-mail folders for attachments. It imports these files to specified 
PaperPort DesktopDelivery folders (i.e. PaperPort folders designated to receive 
files from a monitored folder outside PaperPort). Right-click on any PaperPort 
folder and select DesktopDelivery from the shortcut menu. 

Refer to the PaperPort Help for details.

Import pictures from your camera
To bring digital photos on the PaperPort desktop, first plug your camera in. If 
your device is displayed as a drive you can start acquiring your files. If your 
camera does not support this kind of operation, and its driver is installed 
properly, its TWAIN or WIA interface will display enabling you to import 
images from it.

Do not edit the images on your camera in place – not all editing produces the 
desired result first time. Instead, bring your files into PaperPort and use the SET 
tools to enhance them.

Monitored e-mail inbox folder

Monitored folder
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Touching Up Images
When you display an image item in the Page View window, PaperPort provides 
several tools you can use to adjust or improve your image. 

For example, you can straighten a scanned page, lighten an underexposed 
photograph that is too dark, adjust the color in a color picture, remove “dirt 
spots” from a document page, or sharpen fuzzy pictures. In addition, you can 
rotate an item, remove stray dots, enhance lines, remove red eye, and crop part of 
an image. 

Scanner Enhancement Technology tools

Select Area Use the Select Area tool to select part of an image you want to 
cut, copy, or delete using the commands on the Edit menu or 
in the shortcut menu. Use it also to select part of an image 
before cropping or using the Remove Red Eye tool.

Rotate an 
image

Click the Rotate Right tool to rotate the selected item 90 
degrees to the right.

Straighten an 
image

Sometimes a document is crooked when scanned. When this 
occurs, you can use the Straighten and Auto Straighten tools 
to adjust it. 

Enhance an 
image 

The Auto Enhance feature adjusts the brightness and 
contrast, color, and tint of an image. PaperPort analyzes the 
image and tries to correct whatever is wrong with the 
image.

You can manually adjust your image using the Enhance tool. 

Sharpen an 
image 

Select the Sharpen tool to adjust the sharpness of a blurry 
picture or blur a sharp image for special effect.

Remove red 
eye
 

The Remove Red Eye tool helps you to remove the red-eye 
effect that occurs when photographing people or animals in 
low light or with a flash.
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Edit multiple images
The ability to process items as a group is often referred to as batch processing. 
PaperPort provides batch processing features so that you can quickly enhance, 
modify, or rotate multiple image items in a single operation.

Select one or more image items on the desktop, and then, on the Item menu, 
point to SET Tools, and select the desired command. See the online Help for 
more information.

Annotating Pages
PaperPort includes a collection of annotation tools that allow you to mark up 
scanned documents with information you would like to keep with that 
document. 

On PDF and PaperPort Image (.max) files, annotations are editable, meaning 
that you can reposition, change, or remove them – or edit textual content –
whenever you want. On other types of image items, such as JPEG and Windows 
Bitmap files, annotations become a permanent part of the image when you save 
the item. For item types that cannot accept annotations, PaperPort automatically 
disables the annotation tools. 

Remove part 
of an image
 

When you want to save or work with only part of a page or 
image, you can crop the image or you can erase the part that 
you do not want to use. 

Use the Selection tool to define the part you want to keep and 
then use the Crop tool to remove the remainder.

Select the Eraser tool to erase the area of the image that you 
draw over with the pointer.

Remove stray 
dots 

Scanned images sometimes include stray dots or “speckles”. 
The Remove Stray Dots tool automatically finds and removes 
such “dirt” from a page. 

Improve lines The Improve Lines tool darkens lines and connects broken 
lines in a table or form to appear darker and straighter. 
22 Annotating Pages



Using PaperPort’s annotation tools, you can add notes and text, highlight text, 
draw lines and arrows, or stamp a picture onto an image item.

It is easy to send a document with annotations to people without PaperPort by 
using the PDF Image format. The recipient only has to double click on the 
e-mail attachment they receive from you and they will see the document in 
Adobe Acrobat – annotations intact.

Annotation tools
You can select an annotation tool from the Annotation toolbar whenever you 
display an image item in the Page View window. Right-click on a tool to choose 
settings for the annotation.

Select 
Annotation 

Use this tool to select an annotation so that you can then 
move, cut, copy, or resize it on the page.

Note Want to give yourself a reminder? Select the Note tool and 
add a resizable note much like a sticky note that you write on 
and then stick on paper documents.

Text Adding a text label to your images is simple with the Text 
tool. Select this tool to add a line of text with a transparent 
background. 

Highlighter Use the Highlighter tool to highlight any area of the image, 
just as you might use a highlighting pen on paper.

Pencil The Pencil tool lets you draw freehand lines or marks on the 
page.

Arrow or 
Line 

Select the Arrow or Line tool to draw straight lines, with or 
without arrowheads, on a page. 

Stamp The Stamp tool lets you paste the bitmapped image of your 
choice on the page, much like using a rubber stamp.   
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Protecting Items
In PaperPort Professional 10, you can adjust the security level of your PDF files 
(supported up to format 1.5). When you create a new PDF from existing ones 
(for example, by copying a thumbnail of a page onto a Workspace) its security 
settings will be the same as those of the original one. Newly created PDF files will 
be generated according to the default PDF security settings in PaperPort, as 
specified under the Tools menu.

There are two types of passwords in the program. The open password restricts 
document accessibility: you can only open it by supplying the password when 
prompted. The permissions password allows users to define how the document 
may be used. If it is not specified, further use of the file is possible without any 
restrictions. 

Filing Items
A key to organizing items in PaperPort is filing items in appropriate folders. You 
can drag and drop items from one folder to another or from the PaperPort 
desktop into any folder you want. You can specify search criteria to help you find 
your items later. Moving and copying items between folders is also possible in 
split view across Workspaces. The name of each item appears below the 
thumbnail in thumbnail view. In a multi-page item, the name appears below the 
individual page names.

Using the Folder Manager dialog box, you can add, remove, move, and rename 
PaperPort folders. You can change the color of a folder icon to one that helps you 
organize your items. You may also add, remove, move, and rename any folder in 
Windows Explorer that is viewed with the PaperPort folder structure. These 
changes will be automatically reflected in PaperPort.

In the Folders pane, you can drag and drop, copy or move subfolders and their 
content to other subfolders or PaperPort folders, create subfolders, and delete 
subfolders. Sharing and Security, and DesktopDelivery adjustments can also be 
directly made for each folder shortcut menu. 
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The Back button makes it easy to step through the ordered history of folders you 
recently visited one by one – functioning similarly to Internet Explorer – 
enhancing quick backward navigation for both Workspaces independently of 
each other.

Add search criteria to items
You can assign item properties to PaperPort Image items and PDF files, and then 
use the properties as search criteria to find items in PaperPort. 

PaperPort also allows you to assign the same keywords to multiple items at the 
same time, providing a powerful tool for organizing and locating similar 
documents and images. 

Select multiple items on the PaperPort desktop, then choose Properties from the 
shortcut menu; words entered under Subject, Author and Keywords will be 
applied to all selected items.
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Finding Items
PaperPort provides features to help you find your PaperPort items. You can 
quickly find an item by visually browsing through thumbnails on your PaperPort 
desktop. 

When you have many folders and items, PaperPort provides more powerful 
capabilities with All-in-One SearchTM. 

All-in-One Search provides many options for specifying where and what to look 
for when finding an item, including indexed text content. The information you 
want to find is referred to as search criteria. 

You can look for items by:

• Item properties

• Text content 

Find items by their properties
You can search for any type of item by its item name.

You can also search for PDF and PaperPort Image (.max) files by item properties, 
such as keywords and subject information. 

When you search by item properties, you can specify criteria of an item name, 
author, added comments or keywords, text in annotations, or the URL of a 
captured web page. 

Find words in an item
To search for words within an item, you need to add the item to the All-in-One 
Search index and check Use All-in-One index. When you search using the 
index, you can find items that have been indexed by their properties, or text 
content, or both.
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Add items to the All-in-One Search index
The All-in-One Search index uses PaperPort’s OCR software to extract and copy 
textual content from your items, and creates a database of the words or phrases in 
those items, much like the index of a book.

Item properties, such as name and author, are also added to the index.

Although creating an index is time consuming, searching for items in the index 
may be much faster than searching file by file.

Using PaperPort Options available from the Tools menu, you can specify 
whether you want All-in-One Search to run automatically each time you add a 
new item or modify an existing item. You can also set how long PaperPort should 
wait before starting the update process.

If you prefer, you can manually update the All-in-One Search index for all items, 
a single item, or all items in one or more folders. It is good practice to update the 
All-in-One Search index on a regular basis to shorten the length of time required 
to complete the process. 

Use the All-in-One Search pane
Use the All-in-One Search pane to enter search criteria and select options for 
finding your PaperPort items.

A file search is based on item properties only. You enter the item properties in the 
Name, author, keywords box.

An index search references PaperPort’s All-in-One Search index to find item 
properties or actual text contained within an item. You enter the item properties 
in the Name, author, keywords box and the text content in the Containing 
indexed text box.

All-in-One Search returns a list of all the items that match the criteria you 
specify.

Use the Index Manager in PaperPort Professional 10 to create and schedule 
indexing tasks on a regular basis.

For quick access to your regular indexing processes, launch the Index Manager 
directly from the All-in-One Search pane.
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Use PDF Searchable Image
In addition to using PaperPort’s proprietary search and indexing capabilities, you 
can also create PDF Searchable Image files that can be indexed and searched 
outside of PaperPort.

PDF Searchable Image is a flavor of PDF. A PDF Searchable Image file contains a 
bitmapped image of a document or graphic with textual content stored as hidden 
text. This format maintains an identical appearance to the original document 
and enables other programs, such as Adobe Acrobat, to search the contents of the 
file. 

You can create files in PDF Searchable Image format, if you also have ScanSoft 
OmniPage (11 Pro Office or higher) installed with PaperPort 10.

Schedule indexing tasks
The Index Manager is a PaperPort Professional 10 application designed to create, 
modify and schedule indexing tasks for a given local or network folder. Indexed 
files can afterwards be searched with the All-in-One Search. 

For new tasks you can set which folder to browse (local or network) with 
subfolders included or excluded, set timing and recurrence (duration, pattern 
and range), activate and deactivate a task, pause its completion, or skip a task 
occurrence. In the program settings dialog box, you can specify how and when 
the Index Manager should stop.
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Sharing Files
PaperPort provides many tools to make it easy for you to share files, images, and 
documents with friends, colleagues, and business associates. 

These tools are built-in to the program and are readily available on toolbars, 
menus, and command bars for quick access whenever you need them.

To help you share your items with others, PaperPort makes it easy to:

• E-mail items to others, simply by dragging the items to your favorite e-mail 
program on the PaperPort Send To bar.

• Scan or convert items to the PDF format, the ever-popular file-sharing 
format considered by many as the industry standard for document 
distribution.

• Access shared folders located on your local or wide area network, by adding 
the folders to your PaperPort Folder pane.

• Access Sharing and Security settings directly from the folder shortcut menu.

With PaperPort, it is simple to set up a shared folder on a server or a PC that can 
act as a central repository for all important office documents. Each PaperPort 
client can connect to that folder and use PaperPort’s document management 
features and paper handling tools to find and use documents instantly.

In addition, you can convert items to popular output formats for shared use in 
numerous other programs, such as Microsoft Word, Adobe Acrobat, Claris 
HomePage, and Adobe Photoshop. To obtain a list of all supported program 
links, visit PaperPort at the ScanSoft web site at www.scansoft.com. 
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Sending Items to Other Programs
Drag and drop functionality makes opening your files in your favorite programs 
a snap. Simply choose the file you want and drop it onto the program icon on the 
Send To bar at the bottom of the PaperPort desktop.

Common office tasks like e-mailing and faxing are now faster than ever. The 
Send To bar makes using scanned documents in other applications easier by 
automatically translating the document into a form that the receiving application 
can understand. 

For example, you can drop a scanned image of a letter onto the Microsoft Word 
link on the PaperPort Send To bar, and PaperPort will recognize that the 
application you are attempting to open needs a text file rather than an image file. 
PaperPort will run OCR for you, and send editable text to Word rather than a 
static image file. 

PaperPort supports a wide variety of programs including word processing, 
spreadsheet, fax, Internet e-mail, graphics, optical character recognition (OCR), 
and online services programs. The program link on the Send To bar does any 
necessary conversion and may provide options for sending the item.

Use OmniPage with PaperPort
If PaperPort exists on a computer with OmniPage Pro, its OCR services become 
available and amplify the power of PaperPort. You can choose an OCR program 
by right clicking on a text application's PaperPort link, selecting Send To 
Options and then selecting OmniPage Pro as the OCR package, instead of the 
always available PaperPort OCR.

OmniPage OP Workflows PDF ConverterMicrosoft Outlook
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With OmniPage you can:

• Instantly convert paper into usable Microsoft® Office documents. 

• Turn PDF files into editable documents while retaining their layout. 

• Create unlimited searchable PDF files for electronic archives. 

• Automatically process images from network MFPs and scanners. 

• Scan and convert documents into XML, PDF, TIFF and more. 

• Share documents using e-mail, Web, XML and e-Books.

• Use OmniPage workflows for instant but effective control over document 
conversions.

Customize the Send To bar
You can change the way program icons appear on the Send To bar in a number of 
ways. Specifically, you can add programs, and remove or rearrange program 
icons. Refer to the PaperPort Help for details.

Adjust Send To options
You can tune Send To options to specify how you want to use a certain program 
on the Send To bar. For example, you can specify the file format in which 
PaperPort will save an item.
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If you have OmniPage Pro 14 or above on your system, use the Send To options 
for the OmniPage Workflows link to choose a workflow.

To e-mail an item, simply drag and drop the item to your e-mail program on the 
Send To bar. Use the e-mail link options to specify the file format of the 
attachments and other options.
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Converting Items 
Using PaperPort, you can convert scanned documents and text items to image 
formats, and convert images back to text. 

Convert items to image formats
You can convert scanned documents and text items to image formats.

The Save As command allows you to save image items to any of a variety of 
standard image formats including PDF, JPEG, and TIFF, as well as the native 
PaperPort Image format (.max). 

 You can convert text items and image items to PaperPort Image items (.max) 
using the Duplicate as PaperPort Image command. The Duplicate as PDF Item 
command allows you to convert text items to PDF Image items. 

In PaperPort Professional 10, you can also convert text items such as Word 
documents, to PDF Formatted Text & Graphics format.

By selecting more than one item, you can convert multiple items to a new format 
at the same time. Refer to the online Help for details.

Convert images to text
You can convert scanned documents to text by a simple drag and drop of the 
thumbnail to your word processor program. PaperPort automatically processes 
your scanned document using PaperPort’s OCR software, launches your word 
processing program, and loads the scanned text into a document ready for 
editing.

In the Page View window, PaperPort also allows you to copy text from part of an 
image item for use in a text editing, word processing, or spreadsheet program.

The OCR software processes the text and copies it to the Windows Clipboard. 
Open the program in which you want to insert the text, and use Paste to paste 
the text in a file.
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Filling Out Scanned Forms
FormTyperTM is a PaperPort program that enables you to fill in forms, such as 
insurance forms, registration cards, and medical forms, that you scan to the 
PaperPort desktop.

You simply drag a form from the PaperPort desktop to the FormTyper program 
on the Send To bar. FormTyper automatically analyzes the form, recognizes the 
blank areas in which data can be entered, and creates blank fields for the data. So 
that you can easily see where to enter data, FormTyper underlines each field in 
color.

Now, you can quickly type and tab to each field. You can also quickly reposition 
fields, insert new fields, and remove fields as necessary. After you enter data and 
complete the form, save the form to the PaperPort desktop so that you can print 
or e-mail the form in its entirety with its completed data.

If you have a pre-printed form, use the Print Only Fields tool to print your 
responses directly onto the form.
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Creating PDF Documents
PDF (Portable Document Format) files are often classified into three different 
types, commonly called flavors:

• PDF Image 

• PDF Searchable Image 

• PDF Formatted Text & Graphics 

You can create one or more of these PDF flavors, depending upon your version of 
PaperPort software. Refer to the PaperPort online Help for additional details. 

This table lists which features are available for creating each type of PDF in 
PaperPort 10 and PaperPort Professional 10:

Format PaperPort 10 
PaperPort 
Professional 10

PDF Image Scan 
Get Photo
Print to PaperPort
Save As
Web Capture

Scan 
Get Photo
Print to PaperPort
Save As
Web Capture

PDF Searchable Image 
(OmniPage Pro required)

Scan
Get Photo
Print to PaperPort
Save As
Web Capture

Scan
Get Photo
Print to PaperPort
Save As
Web Capture
Duplicate Item

PDF Formatted Text & 
Graphics

(Read Only) Print to PaperPort
Duplicate Item
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Using ScanDirect
ScanDirectTM is a PaperPort program that enables you to scan items and send 
them directly to PaperPort or other programs on your computer without first 
running PaperPort.

ScanDirect runs as a separate program from the Windows Start Menu and 
displays the ScanDirect bar.

Using ScanDirect, you can scan an item and immediately send the item to either:

• A program on the ScanDirect Send To bar – Icons on the ScanDirect bar 
represent the programs that are linked to PaperPort and to ScanDirect. To 
scan and then send an item to a certain program, click the program icon, and 
then scan the item. ScanDirect will automatically start that program when 
the scan is complete.

• The PaperPort desktop – To scan and then work with the item in PaperPort, 
click the PaperPort icon, and then scan the item. When the scan is complete, 
PaperPort starts and displays the item in PaperPort. You can then use all of 
PaperPort's features on the item.

Refer to the PaperPort Help for more information about using ScanDirect.

Uninstalling PaperPort 
1. Select Add/Remove Programs from the Control Panel.

2. Select ScanSoft PaperPort 10.0.

3. Click Remove to uninstall the program or Change to auto-repair it.

A de-activation step is performed at the start of un-installation, allowing you to 
reinstall the program later without re-activation problems. De-activation and 
re-activation require web access.
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